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CONTENT BEYOND SYLLABUS

•what-ISEcliese?

In  the  context  of  computing,  Eclipse  is  an  integrated  development  environment  (IDE)  for
developing   applications   using   the  Java   programming   language   and   other  programming
languages such as C/C++,  Python, PERL, Ruby etc.

The Eclipse platform which  provI.des the fou-ndation for the Eclipse ID.E is composed Of plug-
ins  and  is  deiignpd  tn  he  eutensible  using  additional  plug-ins.   Developed  using  Java,  the
Frlirfr`   Illatfr`rrr`   rir`   ho   ucpfl   rr`  rlp`Jplr`ri   rirm   rlient   anriliraTions    inreqrat.ed   development

n       envimnmfnt-s,,  dntj  uiiit9  luuis.  Ei.i;tj5t: Lcnl  Lc UDCJ ds dii  lDE for any progranming  language
roi-which  a  plug-ill  Ts  dvdi[able.

The Javia .Development Toots  (JDT)  project provides a plug-in that allows Eclipse to be used
as  a  Java  IDE,  PyDev  is  a  plugin  that  allows  Eclipse  to  be  used  as  a  Python  IDE,  C/C++
Development Tools (CDT) js a plug-in that allows Ecl,ipse to be used for developing application
using  C/C++,  the  Eclipse  Scala  plug-in  allows  Eclipse  to  be  used  an  IDE  to  develop  Scala
applications and  PHpecfipse is  a  plug-in  to  eclipse that  provides complete  development tool
for PHP.

Licensin
Eclipse  platform  and other plug-ins from the Eclipse foundation  is  released  under the Eclipse
Public  License  (EPL).  EPL  ensures that  Eclipse  is free to  download  and  install.  It  also  allows
Eclipse to be modified and distrit)uted,

Ectiiise-
Every year, since 2006, the Eclipse foundation releases the Eclipse Platform  and a number of
f`ther  p!ijg-ins  !n  ~7ilrva.

rnrtpnarrT-    Y®ar'    Platform version

Callisto              2006     3.2

Eurq&a 2007     3.3
_``          ,` '

\.-   ,

Ganym`ede       2008.3.4
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Galileo                2009     3.5

Helios                  2010/    3.6

Indigo                2011     3.7

Juno                    2012     3.8and4.2

Kepler               2013     4..3

Luna                   2014     4.4.0

m±gEdiEme
You  can  download eclipse from  http://www.eclipse.org/downloads/. The download  page lists
a number of flavors of eclipse.
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Eclipse

_lnollima Edip§e                 .            .                                                                                   _  ___ ___
To install on windows, you need a tool that can extract the contents of a zip file.  For example
you can use:

•     7-ziF,

•    Peazip

IZ-Arc
•Using aFny -on-e -of th-ese to.ols, ,.extra-ct the -contents .of th-e -.eclit}se zip fite to a-ny folder of v-our

choice.

i illffl #*tw"ife#gtthjpeiHtr.a jLsri`LT2 #tr!32ttRErfe.as+T!f3t`

£Sixp    £#fi    ¥*ip*¢F    i flygrftes    ±€*#.#    frL*l¥

EI        ERE

fa-#a€3     Fee?

#&ibi}3#

Sgffe    REas#Sind

#¥S#|#¥t¥}       ES###&.#:fe&    £#&£`S¢  a4.+

Lau"ELEife
On  the  windows  platform,  if you  extracted  the  contents of the  zip  file to  c:\,  then  you  can
start eclipse by using c:\eclipse\eclipse.exe

When  eclipse  starts  up  for the  first time  it  prompts  you  for the  location  of the  workspace
folder.  All  your  data  will
choose a new location.

:ored  in  the  workspace  folder.  You  can  accept the  default  or
t`.

9



®

*
Zngs        *'dyrt*eerq¥`aJr.t®'         .    "i  !{{}fl*3,¥jr`7f?+iif#fr\+rit+Sit¢*,`rittrq ,prat  +.,r€`

If you 's.elect ']U.se thi-s a.s the default and  do .not ask aga.in", thi-s dialog  box wi-ll  not come up
again.  You  can  change  this  preference  using  the  Workspaces  Preference  Page.   See  the
Preference tutorial  page for more details.

` \ t\.



fdeofanEgivsewindoVIr
The major visible parts of an eclipse window are:

Views

•     Editors (a-lT appear in one editor areaj

•      MenuBar

•     Toolbar

An eclipse perspedive -is the name given to an -initial .collection and arrangemem Of views and
an  editor  area.  The  default  perspective  is  called java.  An  eclipse  window  can  have  multiple
perspectives open in it but only one perspective can be active at any point of time. A user can
switch  between  open  perspectives  or open  a  new perspective.  A perspective controls  what
appears jn some menus and tool bars.

L ae#RE#  of  ¢t#tSr*t.                       fa§f3ii3I

i       #®'£p¥*r!rty€       :
1         I,           tJ   I          ,

`Pr,c#a£-Si-#,t,ia,®3

#£+,"-
:   isrchi#{¥\**,!€#
(t,+--,.,.-- i       £rfugivrfii€G        i



A pens.pective 'has only one editor area .in which muitiple editors -can be .open. The editor area
is usually surrounded  by multiple views.  In  general,  editors are ulsed to edit the pro]-ect data
and views are used to view the project metadata.  For example, the package explorer shows
the I.ava files in the project and the java editor is used to edit a java file.

The eclipse  window can  contain  multiple  editors  and  views but only  one  of them  is active  at
any given  point Of time. The title bar Of the active editor or view I-oaks diferent from all the
others.

The UI elements on the menu bar and tool bar represent commands that can be triggered by
an end user.

LJrfui\rfuHierfermdows
Multiple Eclipse Windows can  be open at the same time. To open  a new window,  click on the
Windows menu  and select the New Window menu  item.

Each window can have a different perspective open in them. For example you could open two
ECLipse  windows  one  in the Java  perspective  and- th-e  other  in  the  Debug  perspective.  The
window showing  the Java  perspective  can  be used  for  editing the java  code and  the  window
showing the debug perspective can  be used for debugging the application  being developed.
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T\roical.Eclipse`Menus
lThetypical .menus avaifabte on -:ttre menu bar Of an .E.clipse windemr are=

•      Filemenu

•     Editmenu

•    Navigate nrmu

•     Searchmenu

•      Pr-ojectm-Grid

•     Runrnenu

•     Windowmenu

•     Helpmenu

\
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BrieFdsulonOfMenus

File

Edit

Source

Description

The File menu  allows you to open files for editing, close editors, save ec]itor
content  and  rename  files.   Among  tha  rt.her  tr,ir,g3,  it  a!su  d::uws  you  io
import  and  export Workspace  content  and  .shi!!-f,in\+`tn  Frlin¢p

The Edit menu presents items like copy & paste.

The Source menu  is visible only when  a java  editor is open.  It presents a
number of useful  menu items related to editing java source code.

Navigate       The N-avi.gate menu all-o.ws you-to-qu.i€kl.y I.ocate resou-rces and  n-a-vigate to.
them.

Search           The  Search menu-presen-tsr item-s-tha.t  a-lJ-ow you-to-search-the  workspace
for files that contain specific data.

Pro].ect           The  menu  items related to  building  a  project can  be found  on  the  Project
menu.

The  lnellu  Items  Cm  the  Run  men!j  a!!o`^`/  \..;ou  to  5+ar+  i  rirr,,ir.I,`irTi  ;.    +hn   r!i.-7
.-.HUJL  Ji   uLLu9  illuijt:.  "  diso  Hlesent.s  menu  it.pmc;  thlt  .il!-`.I.J  `,'r,:I  +;-.  \|+T„,.

the lode.

Window       \  The Window menu allows you to open and close views and  perspectives,  It
also allows you to bring up the Preferences .dialog.

Help The   Help   menu   can   be   used   to   bring   up   the   Help   window,   Eclipse
Marketplace  view  or  Install  new  plug-ins.  The  about  Eclipse  menu  item  gives
you version  information.

Customizing Menus
The visible menu  items on  a  menu depend  on the installed  plug-ins and customization done
usin.g the Customize PersjLe_ctLVLg dialog  box.

i_lil,till.,L''+.`..-..-i,.i
'''''`::-..:-:f`,i,^'`frb'bS`YPwfl!f^!C',..r:i.j(',`CjL!,r:'

r.r!£:iNEERlfl;G&TECH..`:`i-``...C.i3`/j`/.`',,>„`

i,v^`iti;`\j'~.,;3



-Aboutvfews

a

Eclipse views allow users to see a graphical  representation of project metadata.  For example
the  project  navigator  view  presents  a  graphical   representation   of  the  folders  and  files
associated  with  a  project  and  properties  view  presents  a  graphical  representation  of  an
element selected in another vieiv or editor.

An eclipse perspective can. show any nt+mber Of views a.nd editors. Ar[ editor irtsta.nces ap.pear
il.i  a  single  edilur  dred,  whereas  views  are  placed  inside  view  folders.  A  workbench  window
can display any number of view folders.  Each view folder can display one or more views.

Qr:g?nizingvlews
The fotTowi.ng .pictu're .sh-ows .fou.r .vi.ews arranged -in  a vie-w folder.

L±    Sfj=!SJ`g.FTi*       -

if itens

Sfr*Tip£7ffrs R€$4ngf€ap                      plc 1 ii Leeft#i#ri

The picture given  below shows the same four views arranged in two view folders.

i.5^     #r&ngt#i€£31£        ;

a t!€fl,'£
pr,  *   -~--+'  iL.   `

PfftprRE¥

`                eras              *h          rTGI         j`fTB

¥#

Eat...   i.-i-i-"J,,+   /--     I.

P.P.I.`=.-i-rc3i±kLSREENARAVA;VA€URUCOLLEGE0F
Ef\iG,'#=ER;NG&aEftt`LOEOGypA`„rfuvuR
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ntwovingviews

To  move a view from one view folder to another, just click on the view title  and  drag to the
title  bar area  of another view folder.  The  green  line shown  below  is  a  result of dragging the
title bar of the Properties view from one view folder to the title bar area of another view folder.
The Properties view can  be moved to where the green  line is by releasing the  mouse  button
and sending out a drop event.

CreatingviewFolders
View  folders  can  be  dynamically  created  by  dra.gging  the  title  bar  of  a  view  to  anywhere
outside the editor area  and title bar of another view folder. As you drag the title bar around,
green lines will  indicate where. exactly the new view folder will be created,

Moving the drag  icon  to tile bottom of a  window. allows you  to create a  view. folder that spans
the entire width of the window. Moving the drag icon to the left or right edge of window allows
you to create a view folder that spans the entire height of the window.

\.

=`+`:`+rtyfa.IL',.   .

L
+`    -.'`&`.s£`    Pst.V.

p-i:t}---.:..,,',i:-i-.-:i.3AL
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To opeii a view,  click un the Wifldow menu and select the Show View menu  item.
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•CLicking on .theother .in.en-u item brings u.p the Show View dialog 'box that allows y.ou to Locate
and activate a view.

{5,  RES  An!
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rfri*     t{`i!tr""~i     t.+L€t-.i  I    JliJ   l\i`*ttrypr{

r-        t.i®,-I,!`,r.+-

The views are organized by category. To quickly rotate a view, j-ust type the name of a view
into the filter text box. To open  a view, select it and click on the OK button. The subsequent
pages of this tutorial introduce you to a number of useful views.

i-,-  I  ,I.
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Using -ECHpse -for Java -Programming

NOTE: Hefore using Eclipse for the flrst time, create a folder on your
desktop named Myworkspace. This folder will be used to store all of
your Java projects.

i      StTlrt FCTH.pse   (Windows. F].nd itimdcr AH  programs in Your sfarfMenu
\,i``,.iJ``iit[i`.`ii     F'u!{{  iL  \ii]{lrr  Go  >  Applicati(Jns  in  the  Find'er.`)

2.     S|`lect €-1  won.kspaci`:

(a) Click on Browse and select the folder Myworkspace from your
Desktt}p. DO NOT USF ANY OTHER WORKSPACF.

"
Sele€1 a warkspe€e

Er:Ipi¢  }D&  5tor'f.£ \ienjr Sgaje{t3  in  ,I f`olHL.r rS!lEd a ¥}c)Sklpa€€
C3`ij®t€  tl  wcLi*£pulca  li)lS{=I  t#. use  tor  th`S  £€sslon

your username §riould be here instead

...v,:\"-,Ow"t"
>y..  teT±trmia6marm

aeri.. `e.caL`  "fo+i`tA,:bet

the F,clipse icon

(b) click OK. After some setup, you will scc the Eclipse SDK window with a
Package Explorer tab:

:-`   1.    i r[--. E=: ¢? t.

-'L3RIJ:\!``.,
£.¥ f`r..-, r`   r  `.

~,
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3.   E.ach Java pi.ogfam wc will wTitc will bc stored in its own pt.ojcct. Fi.om the
Eclip`ie menu bfir zit the toll of the Licreen7 i.lio[]L`e File  >  New >  Java  Project. . .
You will  see the followiiig New Java  Prr)jec`t T``Ti|idc,-``.,I:

If yiiu arL` crL`ating
a Java prii.jcct
from scratch, you
will select the first
op,ion and go ,o
Step 4.

If yliu arc crL.ating
fl Java priljcct
from files given to
you, you will select
Lhe sect)nd o|)Lioli

and go to Step 6.

4.   If you are starting a brand now Java pl.oject without any initial program code:

[rytiu are starling a
Java project using a
foldei. with Java
code that is all.cady
whttcn for you., go
to Stet) 6 instead.

(a)  Tn the New Java Project window, give the proj.ect an appropriate name
that's easy to identify. For example, type in MyFirstprogram as the
Project Name. You will notice that the Location is automatically updated
to be a folder in your workspace wjtli the same name.

ro)  For the "Contents" option, make sure you sclcct "Crcatc new project in
workspace". Generally, you do not need to change any other options in
this window. You should be using Java compiler i.5.0 for your work.

(c)  Click Finish. You will scc the SDK display your pl-oj.cot in the left
colurm, as shown in the picture on the next page.

~T.,

-                 `     \.'|;\L`.`   r    i.

=S`:Lj,,'`,I.g1``..jtj!'...IE:.Cr`i``~;.ueT`,mTT.f`i%i.'.i

i,+4,i.;tl,i`
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5.   Each program has one or more classes, one of which must contain a main
method.  To add a class to a proj.ect:

(a) Be sure that the name of the project folder is highlighted (e.g. see picture
flbove).

a)) Then, from Eclipse's menu bar at the top of your d-esktop, select New >
Class. (See next page f`or a picture.)

(c)  Type in the name of the class in the space provided (c.g.
FavoriLeFoodDisplayer).

(d)  Select the public mt]difier.

(e) If this class will contain a main method, check off the appropriate box
under "Which method stubs would you like to create?" (In this example,
our class will have a main method.)

J.        i~iL_

JPRI_ ,.,.. u  _,i

.a`rv'tyAf¢!.f   :-, L . : j C:OLLEGfi

!NG&TEcfj.`.:.i`OLOGY,PAYYi

i{Al\?.rt€'|jR



l`hi.i waning can he
ignored t`or  15-100.

(f)  Click Finish. You will see this class appear in the Package Explorer in
your default package.

:i-,:-.:'I:,   ,
Sr':EEN,4uRAVA},`',I.`"rL._',I"........I

ENG!,^qiEERii``'G&T£€,;i!``,.'i_\;.t'LGy,r`,`i`f```,I..;:-u

KAN:i:.,1.:
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/LT:)  Fnt{rr ttir  t`r`llr)v'inLi liiLThl!ghtcd JLi\r+1  iTr)de  exai`tly  as  it aDuears  in  llle

iticiili  iLic;iiiirty  aL`  L`iiuwh below:

I

If you make any syntax errors, you will scc a red X appear to thc left of
the line with the error, Click on the X to get more info about the error if
you need help.

For example, if you leave the quotation marks out from the code above,
you will see something like this:

Syntax error

#Lrfei+#  &t#ti#  ¥S}d  ,"in€Str¢mg[]   ffrgs}   I
/        \,,I,      ^`)~!j..\        `?.*?i{k.   7   {j,    },H.`      y`3&}         .    .3      it±j!,3~4

String  fat®rEt*F'cod  rs"  #„ig;gs:
5y51¢rw.ti#t.#rint{ `ht.}J   i'Qv#r`,|&   tree#   tt4£   to};
i+tsiear6`c*j±.#rinl`l!igfcwoi-ite*cod};

{h) Periodically, save your work using File > Save.

(i)  If your Java program requires more than one class, you can add additional
classes to yollr project, rcpcating the instructions of this step.

0.)   When you arc ready to run your progl-am.. continue with step 7.

6.   If you are creating a project using Java ffles that are already stored in a
folder for you (for example, the folder is named Mysecondprogram):

lf you are starting
a Java project

C     `romscratch, go
back ltl Step 4.

(a) IMPORTANT: Make sure the folder with the`Java files is stor`ed inside
your Myworkspace 1.oldcr bcf'orc you go on to the I.o]]owjn# steps.

(b) For the "Contents" option, select "Create project from existing source". Click
the Browse button to ,sclcct the fe!d§± that contains the Java filcs that you
want to use to create the new project.

(c)  Tn the New `Java Project windt]w, enter the nflmg tjf.the sflme fi]Idej: fls the
tr. i `ujuu,b  ! i*uj i ii;.  \ j.-i  I ill-5L,iige  w'ili  tippcar as you al-C typIIlg  that Wlll  Warn  you

tci use the same nariie as tile project folder.)

(d)  Click Finish. (Scc pictures on next page.)

Jt
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RHMEMBER:
Drag the priijcct
folder into the
Myworkspace
folder FIRST.

G¥SO,¢  a J,a+>a fiF#j€Sl  ,01

For an existing
'g\I

project t.ol dei.,
choose this

+iOption.

®

Mflke ``iil.e Lhe

prt-+ject nalTte and
t.older name are
Lhc samc.

1     i    4'.'\.   V.
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7.    Tt`your pi'o.gram has no syn.tax ett'ors, you can run your program 'as follows:

(a)  In the Package Explorer, you must highlight the Java file that has the
main method in it.

(b) Clioose Run > Run As. .. > Java Application.

(c)  If your program has in syntax errors., your program will run and the output
will be displayed in the Eclipse SDK Console window in the bottom right
section:

-`` .i   #+ #. tS'

p4!tf    i=   it.H±5.   Was,SeffeD{£P`Lay€F

(
-I         r`t>ilc   -~att€  `+Did  "{ti(st7>`rtfrj   4rgi}

t!}3P'tafQu€S+.£o[`*-)i
515tc.ca   {ttlt   .if``flt  LT`(  `{Iontj's '  `}.
a-z5st-iQyrfuestTon{}`,
£`,5£an,   ac.i   pf .r!`t`r,(~8[16)  `?{
¢*-:spZcyfuasltion¢}',
'i,St"„`'J'|  Pr,,'.tl*{' #r^\`IL' -5^|t!l,  Zt! iS  ' l`'iis

s} is¢m, #u\. , pt ` r.i ;nc`tla*iabenmamer#.             `) ,
i

f{uE; ``j:   StE[t`.a   vuic}   dlaplo}r(}iic5*t®n{)
i

5ystt.*,#/{   i.r..l.{"¢.fi#t   ttL!2S   ll{#`+i.   i  `*e        ),-I

I

B coasoie  *`.

I,i

NOTE: Just bccausc your program has no syntax
i`rrors.. this docs not mean your program will Ton
c{]rrccLl-yr Vt)u ctiuld havL`  I.{]gical. {ir runLimL`

errors that the compiler cannot pick up!

8.   To remove a project from your workspace, select the name of a project in the
Pa€ka,ge I.`{plo}.ei. .fc.I.  P4'y'S€c{)ridprcjqrai'ii\.  {tiiti tT.len  choose  Edit >  Delete,
`j_`'L)u  l];-`L\/.c  t`he  oi)(:ic"Li  `']t` i.iJ,nirj`Tiii: ill:t  t!}`-`  ill.i`iji:c[ naiii:  L`i.  iill  ul` Lhe  Code  i`rcm

.  `_,.`.       `.  .`,.I\:_,[j"'iJ     i  i   it!ii!t   i`t\-iL`iJ   Ljeioi.c   }'Ou  du  tliis!)

9.    To exit out of Eclipse, choose File > Exit.
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SREE NARAYANA GURU COIILEGE 0F ENGINEERING TECHNOLOGY ,

DEPARTRENT OF COMPUTER SCIENCE  Att® ENGINEERING

CST 20S OBJECT ORIENTED PROGRAMMING USING JAVA

CONTENT BEYOND  SYLLABUS - ECLIPSE

Mode of Execution:  Study Materials Given

SL.NO: REGISTER NO NAME SIGNATURE

I SNC2lcs00l ABHINAV D -\
2 SNC2lcs002 ABHINAV K rty,
3 SNC2lcs003 ABHINAV K

ha

4 SNC2lcs004 ABHISREE ASHOKAN
--

5 SNC2JCS005 ABtlRAM SUNIL AV`,

6 SNC2lcs006 ADARSH CHANDRAN K V pr-
7 SNC2lcs007 junARSH Kv ®`,
8 SNC2lcs008 ADIHTHYA JITIHSH -.
9 SNC2lcs009 ADWAITH S NIRANJ st
10 SNC21CS010 AKSRAY P K

'yRE
11 SNC21CS0ll f~AFLZAKV

_,

12 SNC2lcs012 AVUDEEP K fflo .
13 SNC2lcs013 AVUPAM K V

-®

14 SNC2lcso]4 ARATHI T V _\

15 SNC2lcs015 AJEN P P #
16 SNC2lcs016 ARJIN K V Jala
17 SNC2lcs017 ASWATHI A V er.
18 SNC2lcs018 ASWATHI K V rfe@±@
]9 SNC2lcs019 AT-KV dffi7'
20 SNC2lcs020 ATHUL pAVITlmAN rtyJ`
21 SNC2lcs02l a SREYAS KRISIINAN •.I_¥E
22 SNC2lcs022 FADI ASLAM P V ife
23 SNC2lcs023 FATHMATH THANS EEIIA fty
24 SNC2lcs024 HAITA C `.RE

•'  I-   I
_\\



A

25 SNC2lcs025 HIBA T K

26 SNC2lcs027 JERLITT VISAL
j<+''dg

27 SNC2lcs028 JIS-KR
28 SNC2lcs029 KEERTENAK

29 SNC2lcs030 M MOIIAMMED FDAN "#
30 SNC2lcs03l MOHAMnmD ZAIIRAN p v

`rty.

31 SNC2lcs032 D ADNAN E M trkK-
32 SNC2lcs033 MOHAMRED AREN NAJEEB

33 SNC2lcs034 D SREREAD SIDHIK

34 SNC2lcs035 D-UDHEEN th
35 SNC21CS036 NArmANA M •,.giv`
'36

SNC2lcs037 NAWAP -#
37 SNC2lcs038 NEERAJ RAVI P V ured.
38 SNC2lcs040 RARANA T P

•`( C¢

39 SNC2lcs041 SAENG V
R!,!Lizfa  ,l

40 SNC2lcs042 SHAHEEM A V >`-  -C~^,
41 SNC2lcs043 SREYAS KRISHNAN

A

42 SNC2ICS044 UTIIARA M V ife
43 SNC2lcs045 VAISENAV K P YELL

44 SNC2lcs046 VISHAK K R CRE
45 SNC2lcs047 VISHAL V V C%'
46 SNC2lcs048 WSIIAK UMESIIAN

47 SNC2lcs049 YADUKRISIINAN K V EL±-  ,

)
P` V.
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SREE NARAYANA GURU COLLEGE OF ENGINEERING ¢`  TECHNOLOGY.    __  _    _

DEPARTRENT oF ConnuTER SCIENCE  AND ENGINEERING

CST 205 OBJECT oRmNTED pROGRAMrmTG uslNG JAVA

CONTENT BEyorm syLLABus - ECLmsE

Med€ of Erecution:  Study Materials Given                                                                          Date of Evaluation: 04/01/Z023

SIJINO: REGISTER NO NARE b-(20)
I SNC2lcs001 ABENAV D 10

2 SNC2lcs002 ABEINAV K 6

3 SNC2lcs003 ABENAV K 6

4 SNC2lcs004 ABHSREE ASHOKAN 8

5 SNC2lcs005 ABIRAM sun 9

6 SNC2lcs006 ADARSH CIIANDRAN K V 10

7 SNC2lcs007 ADARSH KV 11

8 SNC2lcs008 ADIITITIYA JITRESH 6

9 SNC2lcs009 ADWAITEI S NmANT 8

10 SNC21CS010 AISHAY P K 8

11 SNC2lcs0ll AENA FLEA K V 11

12 SNC2lcs012 ANUDEEP K 13

13 SNC21CS013 ArmAI K v 14

14 SNC2lcs014 ARATH T V 11

15 SNC21CS015 ARIEN P P 9

16 SNC2lcs016 AJun K V 8

17 SNC2lcs017 ASWATHI A V 11

18 SNC2lcs018 ASWATH K V 11

19 SNC21CS019 ATTmKv 13

20 SNC2lcs020 ATHUL pAvrrilRAN 11

21 SNC21CS021 8 SREYAS KRISIINAN 9

22 SNC2lcs022 FADI ASLAM P V 10

23 SNC2lcs023 FATH"ATH THANSEEIIA 15

24 SNC2lcs024 HAIFA C 6

25 SNC,2lcs025 HTBA T K /6
26 SNC21CS027 TEELITr VISAL -
27 SNC2lcs028 JIsrm K R

'             7

`       I     -i       `    .

+  -..--- I  -. ==``--',.i::I.I
`9~-?.I.           .`
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28 SNC2lcs029 KEERTHAVA K 8

29 Sl`TttJ21CS030 M MOIIAnmffiD FIDAN 6

30 SNC2lcs03l MollAMhmD ZAHRAN p v 6

31 SNC2lcs032 MUIIAMRED ADNEN E M 6

32 SNC21CS033 MOHAMRED AnmT NATEEB 6

33 SNC2lcs034 MUIIAMMED SHEHZAD SIDlnK 6

34 SNC21CS035 MUTTAMIVIED THAJUDHEEN 9

35 SNC21CS036 NANDANAM 11

36 SNC2lcs037 NAWAP 12

37 SNC2lcs038 NEERAI RAVI P V 11

38 SNC2lcs040 RA-ATP 9

39 SNC2lcs04l SAENGV 8

40 SNC2lcs042 SHAHEEM A V 8

41 SNC2lcs043 SREYAS KRISHNAN 7

42 SNC2lcs044 tJTHARA M V 11

43 SNC2lcs045 VAISENAV K P 9

44 SNC2lcs046 VISHAK K R 11

45 SNC21CS047 VISHAI V V 12

46 SNC2lcs048 VYSHAK URESIIAN 12

47 SNC2lcs049 YADUKRISENAN K V 11

V
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SREE NARAYANA GURU COLLEGE 0F ENGINEHRING ¢ TECHNOLOGY

DELPARTMENT OF COMPUTER SCIENCE AND HNGINEERING

CST 205 OBJECT ORIENTED PROGRAMMING USING JAVA

CONTENT BEYOND SYLLABUS - ECLIPSE

ASSESSMENT - MCQ

QUESTIONS

1 .    What are activities you can do in Eclipse?

a)   Create generic projects

b}   Edit files in a generic text editor

c)   Share files and project jn a CVS (Concurrent Version System) server

d)   All the above

2.   What are the Basic things an ide includes?

a)   Souree code editor

b)   A compiler and/or an inteipreter

c)   Build automation tools

d)   All of these

3.   What are the key Eclipse projects and technologies?

a)   Eclipse platform

b)   Eclipse project

c)    JDT or Java Dcvclopmcnt Tools

d)   All of`thcsc

4.     Which ofthc following is a fcaturc ofthc EL`1ipsc Java D

a-) It allows users to debug code remotely

b) It .`aii automatj.`ally gene].ate c`ode snippets



d) It allows users to step tlirough their code line by !inc

5.      WhatisEclipsc`?

a) A programming language

b) A software dcvclopment environment

c) An operating system

d) A hardware dcvicc

6.    Which programming languages arc supported by Eclipse?

a) Only Java

b) Java alid C++

c) Java, C++, and Python

d) Java, C++, PytholL and many other languages

7.    Which operating systems are supported by Eclipse?

aJ Windows only

b) Linux only

c) Macos only

d) Windows, Linux, and Macos

8,   What is the name of the Eclipse plugin that provides Git integration?

a) EGit

b) CVS

c) SVN

d) Mercurial

c) Spring Tool Suite

the Eclipse plugin that provides support for the Spring Framework?

.    :.+`.V.
•:`.:¢-+-L|

!£;~.`.==.i:,'.a,jav,;\}t!,£`G'jr,ijcGLLEcEoF
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10. Which ofthc following is a fcaturc of the Eclipse Markctplacc?

a} It allows users to download and install plugins

b) It provides a platform for buying and selling Eclipse plugins

c`) It is a tool for managing source code repositories

d) It is a social networking site for Eclipse developers

11. Which of the following is not a view in the Eclipse IDE?

a) Package Explorer

b) Console

c) Properties

d) Compiler

12. Which of the following is a feature Of the Eclipse debugger?

a) It allows users to step through their code line by line

b) It can detect and fixL common coding errors

c) It automatically generates test cases for the code

d) It provides real-time performance metrics for the code

13. Which of the following is not a perspective in the Eclipse IDE?

a) Java

b) Debug

c) Web

d) Database

14. Whic]i of the fol]owi]ig is a t`eature of the Eclipse text editor?

a) It provides syntax highlighting for many' programming languages

b) It can automatically generate code snippets

c) It includes a built-in code formatter

d) It allows users to write code in natural language

_-. ,Ail

. L r+iJ CO;LLEGE 0r
•:-..``;-:-`:.fJl.or3+3x,pfrwA`rf`l

•j`t:JP`



a} Code rcfactoring

b) Code covcragc analysis

c) Code completion

d`) Debugging

16. What is the main programming language code developed by eclipse?

a)C

b) JAVA

c) Ci +

d) C/C++

17. What does an Eclipse IDE allows?

a)   Editing the program

b)   Compiling the program

c)   Botha&b
`

d)   Editing ,Building ,Debugging & Compiler

18. What is an Eclipse?

a)   IDE

b)   Software

c)   GNU

d)   Codebase

19. Eclipse is used to develop documents with LaTex.

a)   True

b)   False
.\`

'EL

20. Development enviromnent include the

11'.  LEENA   `+.   ```.
''r\TCIPAL

'-. `  I  .?OLLEGE  OF

•   ,` I `.A,,/.INUR



b)   Classpath

c)   EclipscJDT

d)   IccdTea

ANSWER KEY

I.D

2.D

3.D

4.D

5.8

6.D

7.D

8.A

9.C

10.A

ll.D

12.A

13.D

14.A

15.8

16.8

NI
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CST 205 OBJECT ORIENTED PROGRAMMING USING JAVA

CONTENT BEYOND SYLLABUS -ECLIPSE

ASSESSMHNT - MCQ

QUESTIONS

I .   What are activities you can do in Eclipse?

a)   Create generic projects

b)   Edit files in a generic text editor

c)   Share files and project in a CVS (Concunent Version System) server

d)  All the above  ./

2.   What are the Basic things an ide includes?

a)   Source code editor

b)   A compiler andfor an interpreter

c)   Build automation tools

d)   All of these

3.   What are the key Eclipse projects and techaolodres?

a)   Eclipse platform

b)   Eclipse project

c)    JDT or Java Development Tools

d)  All of these

4.     Which of the following is a feature of the Eclipse Java Debugger?

a) It allows users to debug code remotely

u)It an arutonirndrty grnerde code appds                      ife~

`   ,  A.€`g  OF
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c) It provides real-time performance metrics for the code

d) It allows users to step through

5.     WhatisEclipse?

a) A programming language

b) A software development

c) An operating system

d) A hardware device

I.`      _I.=5       I-.           I.

Orlment

6.   Which programming languages are supported by Eclipse?

a) Only Java

b) Java and CH

c) Java, C++, and Python

d) Java, C++, Python, andrmEEmer languages

7.   Which operating systems are,supported by Eclipse?

a) Windows only

b) Linux only

c) Ma€OS only

d) Windows, Linux, and Macos

8.   What is the name of the Eclipse plugin that provides Git integration?

a'EGit    /
b) CVS

c) SVN

d) Mercurial

9.   What is the name of the Eclipse plugin that provides support for the Spring Framework?

0

a) SpringlDE
`,

J*fty§pri`r|,BSource
.+1
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c) Spring Tool Suite

d) Spring Framework Tools

10. Which of the following is a feature of the Eclipse Ma

a) It allows users to download and install plugins

b) It provides a platform for buying and selling Eclipse plugins

c) It is a tool for managing source code repositories

d) It is a social networking site for Eclipse developers

I I. Which of the following is not a view in the Eclipse IDE?

a) Package Explorer

b) Console

c) Pi.operties

d) Compiler

12. Which of the following is a feature of the Eclipse debugger?

a) It allows users to step through their code line by line

b) It can detect and fix common coding errors

c) It automatically generates test cases for the c

d) It provides real-time performance metrics for the code

13. Which of the following is not a perspective in the Eclipse IDE?

a) Java

b) Debug

c) Web

d) Database

14. Which of the following is a feature of the Eclipse text editor?

a) It pi.ovides syntax highlighting for many programmi
-                    =+`.`

b) It +can automatically generate code snippets



c) It includes a built-in code fonnatter

d) It allows users to write code in natural language

15. Which of the following is not a feature of the Eclipse Java Development Tools (JDT)?

a) Code refactoring

b) Code coverage analysis

c) Code completion

d) Debugging

16. What is the main programming language code developed by eclipse?

a)C

b) JAVA

c) C++

d) C/C++

17. What does an Eclipse IDE allows?

a)  Editingtheprogram   /

b)   Compiling the program

c)   Botha&b

d)   Editing ,Building ,Debugging & Compiler

18. What is an Eclipse?

a,IDE         ,

b)   Software

c)   GNU

d)   Codebase
A

19. Ec,1ip§eti,§ iused to develop documents with LaTex.
.  . a)  T:wc `
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QUESTIONS

I.   What are activities you can do

a)   Create generic projects

in Ecli se?

b)   Edit files in a generic text editor

c)   Share files and project in a CVS (Concurrent Version System) server

d)   All the above

2.   What are the Basic things an ide includes?

a)   Source code editor

b)   A compiler and/or an interpreter

c)   Build automation tools

d)   All of these

3.   What are the key Eclipse projects and technologies?

a)   Eclipse platform

b)   Eclipse project

c)    JDTorJava

d)  All of these

4.     Which of the following is a feature of the Eclipse Java Debugger?

a) It allows users to debug code remotely

b} It can aufomatica]ly generate code snippets



c) It provides real-time performance metrics

d) It allows users to step throuali their code line by line

5.     Vthat is Eclipse?

a) A programming lang

b) A software development environment

c) An operating system

d) A hardware device

6.   Which programming languages are supported by Eclipse?

a) onlyJava L/
b) Java and CH

c) Java, C++, and Python

d) Java, C++, Python, and many other languages

7.   Which operating systems are supported by Eclipse?

a) Windows only

b) Linux only

c) Macos only

d) Windows, Linu Macos

8.   What is the name of the Eclipse plugin that provides Git integration?

a) EGit

b) CVS

c) SVN

d) Mercurial

9.   What is the name of the Eclipse plugin that provides support for the Spring Framework?

a) SpringlDE

I.b).Sprint
`----..-`.a
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c) Spring Tool Suite

d) Spring Framework Tools

10. Which of the following is a feature of the Eclipse Marketplace?

a) It allows users to download and install plugins

b) It provides a platform for buying and selling Eclipse plugins

c) It is a tool for managing source code repositories

d) It is a social networking site for Eclipse developers

I I. Which of the following is not a view in the Eclipse IDE?

a) Package Explorer

b) Console

c) Properties

d) Compiler

12. Which of the following is a feature of the Eclipse debugger?

a) It allows users to step through their code line by line  ,:  11-`-:ii`.l`

b) It can detect and fix common coding errors

c) It automatically generates test cases fo.r the code

d) It pi-ovides real-time performance metrics for the code

13. Which of the following is not a perspective in the Eclipse IDE?

a) Java

b) Debug

c) Web

d) Databas

14. Which of the following is a feature of the Eclipse text editor?

a) It pi.ovides syritax highlighting for many programming languages

b) It can automatically generate code snippets



c) It includes a built-in code formatter

d) It allows users to write code in natural language

15. Which of the following is not a feature of the Eclipse Java Development Tools (JDT)?

a) Code refactoring

:na7
b) Code coverage

c) Code completion  /

d) Debugging

16. What is the main prQgramming language code developed by eclipse?

a)C

b) JAVA

c) C++

d) C/C++

17. What does an Eclipse IDE allows?

a)   Editing the program

b)   Compiling the program

c)   Botha&b

d)   Editing ,Building ,Debugging & Compiler

18. what is an

a)   IDE

b)   Software

c)   GNU

d)   Code base
ET

i.

19.,Eclipse is\,used to develop documents with LaTex.
.--..     `   1  -   -
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a)   True

b)   False

20. Development environment include the

a)   Eclipse visualAge

b)   Classpath

c)   Eclipse JD

d)   IcedTea
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